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1. INTRODUCTION & OVERVIEW

The Rabbit 3000 is a modern 8-bit microprocessor that is the cen-
tral element of a complete and fully supported embedded design
system that includes development tools, software libraries, core
modules, sample designs, a parts store, and readily available
expert, human support.

This Development Kit has the essentials that you need to design
your own microprocessor-based system, and includes a complete
Dynamic C software development system. This Development Kit
contains a powerful RabbitCore module (the RCM3110) and Pro-
totyping Board that will allow you to evaluate the Rabbit 3000
and to prototype circuits that interface to a Rabbit 3000 micropro-
cessor. You will also be able to write and test software for the
RCM3100 series RabbitCore modules.

1.1 Rabbit 3000 Microprocessor

The Rabbit 3000 microprocessor shares its instruction set and conceptual design with the
successful Rabbit 2000. The instruction set is based on the Z80/2180, but has been
adapted to be C-friendly and to allow a megabyte of code space. Rabbit processors are fast
with compact code.

The Rabbit 3000 has an extensive array of on-chip peripherals including 6 serial ports, 56
parallel 1/0 pins, motion control interfaces, a time/date clock, glueless memory and 1/0
interfacing, a slave interface, and in-circuit programming. Low-EMI features such as a
clock spectrum spreader eliminate schedule-wrecking EMI problems.

Software development support is based on Z-World’s Dynamic C, and includes extensive
libraries for chip peripherals and more.

Refer to the Rabbit 3000 Microprocessor User’s Manual for complete information on the
Rabbit 3000 microprocessor and complete specifications.
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1.2 RCM3100 Series RabbitCore Modules

The RCM3100 series RabbitCore modules are designed for use on a customer-supplied
motherboard that supplies power and interfaces to real-world 1/0O devices. Their two 34-
pin connection headers provide 54 digital parallel user 1/O lines, shared with five serial
ports, along with control lines. A sixth serial port and one additional 1/O line are available
on the programming header.

A fully enabled slave port permits glueless master-slave interface with another Rabbit-
based system. The slave port may also be used with non-Rabbit systems, although addi-
tional logic may be required.

The RCM3100 series is equipped with 256K-512K flash memory and 128K-512K static
RAM.

There are two production models in the RCM3100 series. If the standard models do not
serve your needs, other variations can be specified and ordered in production quantities.
Contact your Z-World or Rabbit Semiconductor sales representative for details.

Table 1 below highlights the differences between the two models in the RCM3100 family.

Table 1. RCM3100 Versions

Feature RCM3100 RCM3110
Microprocessor Rabbit 3000 running at 29.4 MHz
Flash Memory 2 x 256K 256K
Static RAM 512K 128K

6 shared high-speed, CMOS-compatible ports:
6 are configurable as asynchronous serial ports;
4 are configurable as clocked serial ports (SPI);
2 are configurable as SDLC/HDLC serial ports;
1 asynchronous clocked serial port is dedicated
for programming

Serial Ports

NOTE: The RCM3110 is the RabbitCore module supplied with the Development Kit.

In addition, there is an RCM3000 series of RabbitCore modules that includes Ethernet con-
nectivity.

The RabbitCore modules can be programed locally, remotely, or via a network using
appropriate interface hardware.
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1.2.1 Physical & Electrical Specifications
Table 2 lists the basic specifications for the RCM3100.

Table 2. RCM3100 Specifications

Specification Data
Power Supply 3.15-3.45V DC (75 mA at 29.4 MHz clock speed)
Size 1.65" x 1.85" x 0.55" (42 mm x 47 mm x 14 mm)
Environmental —40°C to 85°C, 5-95% humidity, noncondensing

NOTE: For complete product specifications, see Appendix A in the RabbitCore
RCM3100 User’s Manual.

The RCM3100 modules have two 34-pin headers to which cables can be connected, or
which can be plugged into matching sockets on a production device. The pinouts for these
connectors are shown in Figure 1 below.

J1 J2
GND [ |m o[ ] STATUS /RES |m o[ PBO
PA7[ o o[ 1 PA6 PB2 |0 o[ 1PB3
PAS[|o o| ] PA4 PB4 |5 | 1PB5
PA3[|o o[ JPA2 PB6 |5 ©| 1PB7
PA1[| o o[ PAO PF4[ | o o[ 1PF5
PF3[|o o[ JPF2 PF6 [ | o o[ 1PF7
PF1 o o[ J1PFO PE7 |0 o[ 1PE6
PCO|o o[ JPC1 PE5[ |0 o| 1PE4
PC2[|o o[ JPC3 PE3[ |0 o| 1PE1
PC4[| o o[ JPC5 PEO |5 o[ 1PG7
PC6 |- o[ JPC7 PG6 |5 ©| 1PG5
PGO |0 o[ PG1 PG4 []o o[ J/IOWR
PG2[ o o[ ]PG3 /IORD | o © [ SMODO
PD4 |0 o[ PD5 SMOD1 |5 5[ J/RESET_IN
PD2 |5 o[ PD3 VRAM [] = &[] VBAT_EXT
PD6 |0 o[ 1PD7 +33VI]o o[ JGND
PDOC| o o[ PD1 nc.L]o o[ TGND
n.c. = not connected
Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 1. RCM3100 Connector Pinout

Getting Started 3



1.3 Development Software

The RCM3100 module uses the Dynamic C development environment for rapid creation
and debugging of runtime applications. Dynamic C provides a complete development
environment with integrated editor, compiler and debugger. It interfaces directly with the
target system, eliminating the need for complex and unreliable in-circuit emulators.

Dynamic C must be installed on a Windows workstation with at least one free serial USB
or COM port for communication with the target system.

NOTE: An RS-232/USB converter is required if you intend to use a USB port on your
computer. Z-World and Rabbit Semiconductor offer a suitable converter—more infor-
mation is available at www.rabbitsemiconductor.com, or you may telephone your
Z-World/Rabbit Semiconductor sales representative or authorized distributor.

See Chapter 3., “Software Installation & Overview,” for complete information on install-
ing Dynamic C.

NOTE: The RCM3100 module requires Dynamic C v7.25 or later for development. A
compatible version is included on the Development Kit CD-ROM.

1.4 How to Use This Manual

This Getting Started manual is intended to give users a quick but solid start with the
RCM3100 series modules. It does not contain detailed information on the module hard-
ware capabilities or the Dynamic C development environment. Most users will want more
detailed information on some or all of these topics in order to put the RCM3100 module to
effective use.

1.4.1 Additional Product Information

Detailed information about the RCM3100 will be found in the RabbitCore RCM3100
User’s Manual, provided on the accompanying CD-ROM in both HTML and Adobe PDF
format.

Some advanced users may choose to skip the rest of this introductory manual and proceed
directly with the detailed hardware and software information in the User’s Manual.

TIP: We recommend that anyone not thoroughly familiar with Z-World controllers at
least read through the rest of this manual to gain the necessary familiarity to make use
of the more advanced information.

1.4.2 Additional Reference Information

In addition to the product-specific information contained in the RabbitCore RCM3100
User’s Manual, several higher level reference manuals are provided in HTML and PDF
form on the accompanying CD-ROM. Advanced users will find these references valuable
in developing systems based on the RCM3100 module:

* Dynamic C User’s Manual
» Dynamic C Function Reference Manual
» Rabbit 3000 Microprocessor User’s Manual
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1.4.3 Using Online Documentation

We provide the bulk of our user and reference documentation in two electronic formats,
HTML and Adobe PDF. We do this for several reasons.

We believe that providing all users with our complete library of product and reference
manuals is a useful convenience. However, printed manuals are expensive to print, stock
and ship. Rather than include and charge for manuals that every user may not want, or pro-
vide only product-specific manuals, we choose to provide our complete documentation
and reference library in electronic form with every development kit and with our Dynamic
C development environment.

NOTE: The most current version of Adobe Acrobat Reader can always be downloaded
from Adobe’s web site at http://www.adobe.com.
We recommend that you use version 4.0 or later.

Providing this documentation in electronic form saves an enormous amount of paper by
not printing copies of manuals that users don’t need.

Finding Online Documents

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, create a new desktop icon that points to default.htm in the
docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our web sites as well.

Printing Electronic Manuals

We recognize that many users prefer printed manuals for some uses. Users can easily print
all or parts of those manuals provided in electronic form. The following guidelines may be
helpful:

* Print from the Adobe PDF versions of the files, not the HTML versions.
 If your printer supports duplex printing, print pages double-sided.

 If you do not have a suitable printer or do not want to print the manual yourself, most
retail copy shops (e.g. Kinkos, AlphaGraphics, etc.) will print the manual from the PDF
file and bind it for a reasonable charge—about what we would have to charge for a
printed and bound manual.
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2. HARDWARE SETUP

This chapter describes the RCM3100 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: This chapter (and this manual) assume that you have the RCM3100 Development
Kit. If you purchased an RCM3100 module by itself, you will have to adapt the infor-
mation in this chapter and elsewhere to your test and development setup.

2.1 Development Kit Contents
The RCM3100 Development Kit contains the following items:

RCM3110 module, 256K flash memory, and 128K SRAM.
RCM3000/RCM3100 Prototyping Board.

AC adapter, 9 V DC, 1 A. (Included only with Development Kits sold for the North
American market. A header plug leading to bare leads is provided to allow overseas
users to connect a power supply compatible with their local mains power.)

10-pin header to DE9 programming cable with integrated level-matching circuitry.
Dynamic C CD-ROM, with complete product documentation on disk.

This Getting Started manual.

A bag of accessory parts for use on the Prototyping Board.

Registration card.
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2.2 Prototyping Board

The Prototyping Board included in the Development Kit makes it easy to connect an
RCM3100 series module to a power supply and a PC workstation for development. It also
provides some basic 1/O peripherals (switches and LEDSs), as well as a prototyping area for
more advanced hardware development.

For the most basic level of evaluation and development, the Prototyping Board can be
used without modification.

As you progress to more sophisticated experimentation and hardware development, modi-
fications and additions can be made to the board without modifying or damaging the
RCM3100 module itself.

The Prototyping Board is shown below in Figure 2, with its main features identified.

[ ——

Voltage
Slave Module RCM3000/RCM3100 Current- Regulators Power
Extension Headers Slave Module Measurement
Connectors Header
A \

IRDA
Transceiver

Batt
N
000000000000 O0OOOO0OO0OO0000

N

C]
RCM3000/RCM3100 |-

00| [EOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOO

%[ JPO0000000000000000000000000000000000

£ POO000000000000000000000000000000JY
000000000000 0OOOO000O00OOOOO0OO000OOJ

Through-Hole
Prototyping Area

Master Module
Connectors

000000000000 O0O0O00000O0O0OOOO000O00OO0000
000000000000 O0O0O00000O00OOOO000O00OO0000

)
= 000000000000 O0OO0O0O0OO0O0O0OO0O0OOO00O0OO000O0) \\
i 0000000,
= 1 I +5V, 3.3V, and
POWQ@J T GND Buses

% tjzs‘ ~oC5
o =1 o] e o}

SMT Prototyping ..
rea

(0] @ ®
R t \ User | co/Keypad
Master Module ese RS 232 LEDs yP
Extension Headers Switch Signal User Col:'l/lr?ggtli?)ns
Header Switches

Figure 2. RCM3000/RCM3100 Prototyping Board
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2.2.1 Prototyping Board Features

Power Connection—A power-supply jack and a 3-pin header are provided for con-
nection to the power supply. Note that the 3-pin header is symmetrical, with both outer
pins connected to ground and the center pin connected to the raw V+ input. The cable
of the AC adapter provided with the North American version of the Development Kit
ends in a plug that connects to the power-supply jack. The header plug leading to bare
leads provided for overseas customers can be connected to the 3-pin header in either
orientation.

Users providing their own power supply should ensure that it delivers 8-24 V DC at
1 A. The voltage regulators will get warm while in use.

Regulated Power Supply—The raw DC voltage provided at the POWER IN jack is
routed to a 5 V switching voltage regulator, then to a separate 3.3 V linear regulator.
The regulators provide stable power to the RCM3100 series module and the Prototyp-
ing Board.

Power LED—The power LED lights whenever power is connected to the Prototyping
Board.

Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM3100’s /RESET_IN pin. Pressing the switch forces a hardware reset of the system.

I/O Switches and LEDs—Two momentary-contact, normally open switches are con-
nected to the PGO and PG1 pins of the master RCM3100 module and may be read as
inputs by sample applications.

Two LEDs are connected to the PG6 and PG7 pins of the master module, and may be
driven as output indicators by sample applications.

Prototyping Area—A generous prototyping area has been provided for the installation
of through-hole components. +3.3 V, +5 V, and Ground buses run around the edge of
this area. Several areas for surface-mount devices are also available. (Note that there
are SMT device pads on both top and bottom of the Prototyping Board.) Each SMT pad
is connected to a hole designed to accept a 30 AWG solid wire.

Slave Module Connectors—A second set of connectors is pre-wired to permit instal-
lation of a second, slave RCM3100 series or RCM3100 series module. This capability
is reserved for future use, although the schematics in this manual contain all of the
details an experienced developer will need to implement a master-slave system.

Module Extension Headers—The complete pin sets of both the MASTER and
SLAVE RabbitCore modules are duplicated at these two sets of headers. Developers
can solder wires directly into the appropriate holes, or, for more flexible development,
26-pin header strips can be soldered into place. See Figure 1 for the header pinouts.

RS-232—Two 3-wire or one 5-wire RS-232 serial port are available on the Prototyping
Board. Refer to the Prototyping Board schematic (090-0137) for additional details.

A 10-pin 0.1-inch spacing header strip is installed at J5 to permit connection of a ribbon
cable leading to a standard DE-9 serial connector.
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e Current Measurement Option—Jumpers across pins 1-2 and 5-6 on header JP1 can
be removed and replaced with an ammeter across the pins to measure the current drawn
from the +5 V or the +3.3 V supplies, respectively.

* Motor Encoder—A motor/encoder header is provided at header J6 for future use.

* LCD/Keypad Module—Z-World’s LCD/keypad module (Z-World part number
101-0465) may be plugged in directly to headers J7, J8, and J10.
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2.3 Development Hardware Connections

There are four steps to connecting the Prototyping Board for use with Dynamic C and the
sample programs:

1. Attach the RCM3100 series module to the Prototyping Board.

2. Connect the programming cable between the RCM3100 module and the workstation PC.
3. Connect the power supply to the Prototyping Board.

2.3.1 Attach Module to Prototyping Board

Turn the RCM3100 series module so that the mounting holes on the RCM3100 and on the
Prototyping Board line up, as shown in Figure 3 below. Align the module headers J1 and
J2 into sockets J12 and J13 on the Prototyping Board.

Line up mounting|.
holes. ;

= 560000000000000000000000000
000000000000000000000000000000000

m ¢ P000000000000000000000000000000000
RCM3100 - 5 < | 000000000000000000000000000000000)
oO0000000000000000000000000000000000)

000000000000000000000O0000000000000
00000000000000000000000000000000000
000000000000000000000O0000000000000
,mloOOOOOOOPOOOOOOOOOOOOOOOOOOOOOOO

Figure 3. Installing the RCM3100 Series Module on the Prototyping Board

Although you can install a single module into either the MASTER or the SLAVE position
on the Prototyping Board, all the Prototyping Board features (switches, LEDs, serial port
drivers, etc.) are connected to the MASTER position. We recommend you install the
RCM3100 module in the MASTER position unless you plan to use it as a slave with
another RCM3000 or RCM3100 series board.

NOTE: Itisimportant that you line up the pins on headers J1 and J2 of the RCM3100
series module exactly with the corresponding pins of headers J12 and J13 on the Proto-
typing Board. The header pins may become bent or damaged if the pin alignment is off-
set, and the module will not work. Permanent electrical damage to the module may also
result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board headers.
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2.3.2 Connect Programming Cable

The programming cable connects the RabbitCore module to the PC running Dynamic C to
download programs and to monitor the RabbitCore module for debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on
the RCM3100 series module as shown in Figure 4. Be sure to orient the marked (usually
red) edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector,
which is used for a normal serial connection.)

NOTE: Be sure to use the programming cable supplied with this Development Kit—the
programming cable has color shrink wrap around the RS-232 converter section located in
the middle of the cable. Programming cables with clear shrink wrap from other Z-World
or Rabbit Semiconductor kits were not designed to work with RCM3100 series modules.

O0000000OOOOOOOOOOO0OOOOO0O0

oooonooooono oo

UOooooogououooyg

Romt RRCM3000 RABBITCORE iy o
K sard . 000 000000000000000000000000000000000)
o)
jgg MASTER ¢ [0000000000000000000000000000000000
N e
o S 000000000000000000000000000000000)
"EH 2 30 0000%% | M

3 20%%% [ FIOO 0000 000000000000000000000000000000)

o
o
°
§ a2 |
S Jrrrl ¢ wa
LELEE e o
° o
o

0000000
090909

0 0%%%°
w0

POOOOOO0OOOOO0OO0O0OO0OO0OOOOOOOOOOO0O0O0
POOOOOO0OOOOO0OOO0OO0OO0OO0OOOOOOOOO0O0O0
POOOOOOOOOOO0OOO0OO0OO0OOOOOOOOOOO0O0O0

o

L ZoL 12
g o° G Gioco G o <

To a
PC COM port

\ Colored

shrink wrap

N

Colored edge

Programming Cable

Figure 4. Connect Programming Cable to RCM3100

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an
RS-232/USB converter with the programming cable supplied with the RCM3100 series
Development Kit. Contact Technical Support (see Section 2.5.1) for further assistance.
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2.3.3 Connect Power

When all other connections have been made, you can connect power to the
RCM3000/RCM3100 Prototyping Board.

Connect the wall transformer to jack J11 on the Prototyping Board as shown in Figure 5
below.

3-pin
power connector

000000000000 OOOOOOOOOOOO0O0
000000000000 0O00O0O0OO0O0OOO0O00OOJ
< 000000000000 0O00O0O00O0OO0OOO0O0OOOJ

000000000000 000O00O0OO0O0OOOOO0OOOJ
2 POOOO0O000000000000000O0000OO0O0O000O0
000000000000 000O00O000000OO0O00O00O00000
00000000000 00O0O0O00O0000O0OO0OOO0O0O000
000000000000 000O0O0000O0O0O00O00O00000
OOOOOOOI

L
F
QQO0Q0000QON " ¢

% NJ %;{)‘gtjﬂ “30[100 ‘ :
P
8 s kg

QPR

Figure 5. Power Supply Connections

Plug in the wall transformer. The power LED on the Prototyping Board should light up.
The RCM3100 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow hardware reset
without disconnecting power.

To power down the Prototyping Board, unplug the power connector from J11. You should
disconnect power before making any circuit adjustments in the prototyping area, changing
any connections to the board, or removing the RCM3100 from the Prototyping Board.

2.3.3.1 Overseas Development Kits

Development kits sold outside North America include a header connector that may be
connected to 3-pin header J9 on the Prototyping Board. The connector may be attached
either way as long as it is not offset to one side. The red and black wires from the connec-
tor can then be connected to the positive and negative connections on your power supply.
The power supply should deliver 8 V-24 V DC at 1 A.
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2.4 Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming
connections by running a sample program.

Find the file PONG. C, which is in the Dynamic C SAMPLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open and will dis-
play a small square bouncing around in a box.

This program shows that the CPU is working.
2.5 Where Do | Go From Here?

We recommend that you proceed to the next chapter and install Dynamic C (if you do not
already have it installed), then run the PONG. C sample program to verify that the
RCM3100 module and the Prototyping Board are set up and functioning correctly.

If everything appears to be working, we recommend the following sequence of action:

1. Run all of the sample programs described in Section 3.4 to get a basic familiarity with
Dynamic C and the RCM3100 module’s capabilities.

2. For further development, refer to the RabbitCore RCM3100 User’s Manual for details
of the module’s hardware and software components.

A documentation icon should have been installed on your workstation’s desktop; click
on it to reach the documentation menu. You can create a new desktop icon that points to
default.htm in the docs folder in the Dynamic C installation folder.

3. For advanced development topics, refer to the Dynamic C User’s Manual, also in the
online documentation set.

2.5.1 Technical Support

NOTE: If you purchased your RCM3100 series module through a distributor or through a
Z-World or Rabbit Semiconductor partner, contact the distributor or partner first for tech-
nical support.

If there are any problems at this point:

¢ Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at
www.zworld.com/support/.

» Use the Technical Support e-mail form at www.zworld.com/support/.
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3. SOFTWARE INSTALLATION & OVERVIEW

To develop and debug programs for the RCM3100 (and for all
other Z-World and Rabbit Semiconductor hardware), you must
install and use Dynamic C. This chapter takes you through the
installation of Dynamic C, and then provides a tour of its major
features with respect to the RCM3100.

3.1 An Overview of Dynamic C

Dynamic C integrates the following development functions into one program:

Editing

Compiling

Linking

Loading

In-Circuit Debugging

In fact, compiling, linking and loading are one function. Dynamic C does not use an In-
Circuit Emulator; programs being developed are downloaded to and executed from the
“target” system via an enhanced serial-port connection. Program development and debug-
ging take place seamlessly across this connection, greatly speeding system development.

Other features of Dynamic C include:

Dynamic C has an easy-to-use built-in text editor. Programs can be executed and
debugged interactively at the source-code or machine-code level. Pull-down menus and
keyboard shortcuts for most commands make Dynamic C easy to use.

Dynamic C also supports assembly language programming. It is not necessary to leave
C or the development system to write assembly language code. C and assembly lan-
guage may be mixed together.

Debugging under Dynamic C includes the ability to use pri nt f commands, watch
expressions, breakpoints and other advanced debugging features. Watch expressions
can be used to compute C expressions involving the target’s program variables or
functions. Watch expressions can be evaluated while stopped at a breakpoint, single-
stepping, or while the target is running its program.
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» Dynamic C provides extensions to the C language (such as shared and protected vari-
ables, costatements and cofunctions) that support real-world embedded system devel-
opment. Dynamic C supports cooperative and preemptive multi-tasking.

» Dynamic C comes with many function libraries, all in source code. These libraries sup-
port real-time programming, machine level 1/O, and provide standard string and math
functions.

» Dynamic C compiles directly to memory. Functions and libraries are compiled and
linked and downloaded on-the-fly. On a fast PC, Dynamic C can load 30,000 bytes of
code in 5 seconds at a baud rate of 115,200 bps.

3.1 Hardware Requirements

To install and run Dynamic C, your system must be running one of the following operating
systems:

* Windows 95

» Windows 98

* Windows NT

* Windows Me

*  Windows 2000

* Windows XP

3.1.1 Hardware Requirements

The PC on which you install Dynamic C for development of RCM3100-based systems
should have the following hardware:

» A Pentium or later microprocessor

e 32 MB of RAM

» At least one free COM (serial) port for communication with the target systems
* A CD-ROM drive (for software installation)
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3.2 Installing Dynamic C

Insert the Dynamic C CD-ROM in the drive on your PC. If autorun is enabled, the CD
installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows
Start | Run menu or Windows Disk Explorer to launch SETUP.EXE from the root folder
of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the
process are self-explanatory and not covered in this section. Selected steps that may be
confusing to some users are outlined below. (Some of the installation utility screens may
vary slightly from those shown.)

3.2.1 Program & Documentation File Location

Dynamic C’s application, library and documentation files can be installed in any conve-
nient location on your workstation’s hard drives.
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okl mares o clich. the Browie bufioe ba el 4 rew kcales

IC 'DORAEET_TARE

© fack | Hel | Card

The default location, as shown in the example above, is in a folder named for the version
of Dynamic C, placed in the root folder of the C: drive. If this location is not suitable, enter
a different root path before clicking Next >. Files are placed in the specified folder, so do
not set this location to a drive’s root directory.
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3.2.2 Installation Type

Dynamic C has two components that can be installed together or separately. One compo-
nent is Dynamic C itself, with the development environment, support files and libraries.
The other component is the documentation library in HTML and PDF formats, which may
be left uninstalled to save hard drive space or installed elsewhere (on a separate or net-
work drive, for example).
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The installation type is selected in the installation menu shown above. The options are:

» Typical Installation — Both Dynamic C and the documentation library will be
installed in the specified folder (default).

* Compact Installation — Only Dynamic C will be installed.

* Custom Installation — You will be allowed to choose which components are
installed. This choice is useful to install or reinstall just the documentation.
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3.2.3 Select COM Port

Dynamic C uses a COM (serial) port to communicate with the target development system.
The installation allows you to choose the COM port that will be used.

Dipewmn: [ Special Edelian Verngn 7 HIGE
Sslup Type s
i has g e g bt ity poad resd
e (C1144 Pt
T COun
™ COMZ
i Bach, | Pt I Larcul I

The default selection, as shown in the example above, is COM1. You may select any avail-
able port for Dynamic C’s use. If you are not certain which port is available, select COML1.
This selection can be changed later within Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-
fying a port in use by another device (mouse, modem, etc.) may lead to a message such
as"coul d not open serial port" when Dynamic C is started.

3.2.4 Desktop Icons

Once your installation is complete, you will have up to three icons on your PC desktop, as
shown below.

L b

Diyrarmic C DC 7.205E DC 7.205E
7.205E Docs RFU

One icon is for Dynamic C, one opens the documentation menu, and the third is for the
Rabbit Field Utility, a tool used to download precompiled software to a target system.

Getting Started 19



3.3 Starting Dynamic C

Once the RCM3100 is set up and connected as described in Chapter 2 and Dynamic C has
been installed, start Dynamic C by double-clicking on the Dynamic C icon. Dynamic C
should start, then look for the target system on the COM port you specified during installa-
tion (by default, COM1). Once detected, Dynamic C should go through a sequence of
steps to cold-boot the module and compile the BIOS.

If you receive the message beginning " Bl OS successful Iy conpil ed" you are
ready to continue with the sample programs.

3.3.1 Communication Error Messages

If you receive the message "No Rabbit Processor Detected," the programming
cable may be connected to a different COM port, a connection may be faulty, or the target
system may not be powered up. First, check to see that the power LED on the Prototyping
Board is lit and that the jumper across pins 5-6 of header JP1 on the Prototyping Board is
installed. If the LED is lit, check both ends of the programming cable to ensure that it is
firmly plugged into the PC and the RCM3100 series module’s programming port. If you
are using the Prototyping Board, ensure that the module is firmly and correctly installed in
its connectors.

If there are no faults with the hardware, select a different COM port within Dynamic C.
From the Options menu, select Communications. The dialog shown should appear.
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Select another COM port from the list, then click OK. Press <Ctrl-Y> to force Dynamic C to recom-
pile the BIOS. If Dynamic C still reports it is unable to locate the target system, repeat the above
steps until you locate the active COM port.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message, it is possible that your PC cannot handle the 115,200 bps baud rate.
Try changing the baud rate to 57,600 bps as follows.

» Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Change the baud rate to 57,600 bps.
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3.4 Sample Programs

To help familiarize you with the RCM3100 modules, Dynamic C includes several sample
programs. Loading, executing and studying these programs will give you a solid hands-on
overview of the RabbitCore’s capabilities, as well as a quick start with Dynamic C as an
application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of ANSI
C. If you do not, see the introductory pages of the Dynamic C User’s Manual for a sug-
gested reading list.

Of the many sample programs included with Dynamic C, several are specific to the
RCM3100. These programs will be found in the Sanpl es/ RCVB100 folder.

We suggest that you examine the following five of these sample programs in order to get a
tour of some of the capabilities of the RCM3100 modules.

e CONTROLLED. c—This sample program demonstrates the controlling port outputs
from STDIO by toggling LEDs on the Prototyping Board.

e FLASHLED1. c—This assembly program uses costatements to flash LEDs DS1 and
DS2 on the Prototyping Board at different intervals.

* FLASHLED2. c—This program uses cofunction and costatements to flash LEDs DS1
and DS2 on the Prototyping Board at different intervals.

* | R_DEMO. c—This program demonstrates sending packets (Modbus ASCII) back and
forth over an IR link. This demo requires two RCM3000/RCM3100 Prototyping
Boards with an RCM3100 module on each Prototyping Board. Set up the Prototyping
Boards so that their IR transceivers are facing each other. Load the program into one
RCM3100, then operate this RCM3100 in Run mode without a programming cable
attached. Program the other RCM3100 and then observe the results in the STDIO win-
dow on your PC with the PROG connector on the programming cable still connected.

* TOGGLESW TCH. c—This program uses costatements to detect switches using the
press-and-release method of debouncing. Corresponding LEDs DS1 and DS2 on the
Prototyping Board turn on or off.

The Sanpl es/ RCM3100/ Ser i al folder provides samples to illustrate serial communi-
cation with the RCM3100.

Each of these programs is fully commented within the source code. Refer to these com-
ments for the details of how each program works.

To run a program, open it with the File menu (if the sample program is not already open),
compile it using the Compile menu, and then run it by selecting Run in the Run menu.

Once you have loaded and executed these programs and have an understanding of how
Dynamic C and the RCM3100 modules interact, you can move on and try the other sam-
ple programs, or begin building your own.
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NOTICE TO USERS

ZWORLD PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE-
SUPPORT DEVICES OR SYSTEMS UNLESS A SPECIFIC WRITTEN AGREEMENT REGARDING
SUCH INTENDED USE IS ENTERED INTO BETWEEN THE CUSTOMER AND Z-WORLD PRIOR
TO USE. Life-support devices or systems are devices or systems intended for surgical implantation into the
body or to sustain life, and whose failure to perform, when properly used in accordance with instructions for
use provided in the labeling and user’s manual, can be reasonably expected to result in significant injury.

No complex software or hardware system is perfect. Bugs are always present in a system of any size. In
order to prevent danger to life or property, it is the responsibility of the system designer to incorporate
redundant protective mechanisms appropriate to the risk involved.

All Z-World products are 100 percent functionally tested. Additional testing may include visual quality con-
trol inspections or mechanical defects analyzer inspections. Specifications are based on characterization of
tested sample units rather than testing over temperature and voltage of each unit. Z-World products may
qualify components to operate within a range of parameters that is different from the manufacturer’s recom-
mended range. This strategy is believed to be more economical and effective. Additional testing or burn-in
of an individual unit is available by special arrangement.
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SCHEMATICS

090-0144 RCM3100 Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0144.pdf

090-0137 RCM3000/RCM3100 Prototyping Board Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0137.pdf

090-0156 LCD/Keypad Module Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0156.pdf

090-0128 Programming Cable Schematic

www.rabbitsemiconductor.com/documentation/schemat/090-0128.pdf

The schematics included with the printed manual were the latest revisions available at the
time the manual was last revised. The online versions of the manual contain links to the
latest revised schematic on the Web site. You may also use the URL information provided
above to access the latest schematics directly.
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